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WELCOME 

 
 In this chapter: 

This user guide, dedicated to Advance Steel  is structured into 8 
chapters describing a steel construction project from start to fin-
ish. 

All software tools described in this guide and all remarks related to 
the product pertain only to the Advance Steel and for reading sim-
plification only the generic name Advance is used. 

 

ƴ Introduction 

ƴ Specialized areas 

ƴ Advance and CAD platform 

ƴ Technology 

ƴ Communication options 

ƴ Individual preferences 
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Introduction 

This user guide for Advance is an introduction to working with Advance, describing the basic Advance method-
ology with detailed description of the most important tools. 

The user guide can be used as a learning tool but is also useful as a basic reference for individual topics using 
the index. 

Since not all Advance tools are described in detail in this guide, refer to the Help for more information on all 
commands and parameters. The general Advance work methodology is explained in this Introduction, includ-
ing typical industry applications for Advance, exchanging information and specific user software configuration. 

The Creating a 3D model chapter explains the use of the most common Advance construction elements (i.e., 
beams, plates, connection elements, structural elements such as stairs) and joints. Using simple examples, a 
general overview of the basic tools and methods used to create a model is presented. 

The Numbering chapter describes the options provided by Advance to automatically assign model elements 
with clear single part and assembly marks. 

The various methods for Checking the model in Advance will insure a correctly built 3D model and accurate 
bills of materials. This chapter describes the tools for checking collisions in the model and correctness examina-
tions. 

The automated document creation such as bills of materials from the 3D model is presented in the Lists / Bills 
of materials chapter. 

The Creation of general arrangement and shop drawings chapter provides an overview of the diverse op-
tions for automatically creating general arrangement drawings, fabrication, and fitting drawings. It also demon-
strates detail drawing cleanup. 

Advance 

Advance is a leading edge steel construction application integrated into the latest AutoCAD
®
 version under the 

Windows operating system. 

With intelligent Advance objects, a three dimensional model is created and stored in a drawing (in DWG format). 

The Advance Model forms the basis of the 3D construction. It contains and manages objects (e.g., beams, 
plates, bolts, welds) including their features and relationships to each other. Complex structures are created 
using Advance structural elements (e.g., a portal frame or a stairway) with all the required features, joints, and 
connections, within a command. 

The Advance model becomes the master reference for other tools.  

¶ Dimensioned and labeled general arrangement and shop drawings are automatically created from the 
model information. They are stored in separate DWGs using the user preferences for format, page setup 
and drawing look and feel (the Advance drawing style). It is also possible to create several details on a sin-
gle sheet. 

¶ The general arrangement and shop drawings are created from the information contained in the model and 
are managed by the Advance Document Manager. The update tool in the Document Manager makes sin-
gle click drawing adjustments possible after model changes. 

¶ Structured BOMs (bills of materials) and NC-information are also created from the model and include all 
model information such as part marks and quantities. These documents are also managed by the Docu-
ment Manager. Bills of material/structured BOMs and NC-information are listed and previewed in the Doc-
ument Manager. 
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Through multiple interfaces, the communication with GRAITEC and 3
rd

 party engineering applications is guaran-
teed. 

 

Figure 1: Document creation 

Specialized areas 

The Advance 3D steel construction software is adapted to both standard and specialized construction. A variety 
of cold rolled construction systems for purlins, side rails, accessories and cladding sections are available in Ad-
vance (i.e., Albion, Ayrshire, Canam Manac, Canfer, Fisher, HiSpan, Kingspan, Krupp, Metsec, SAB, SADEF, 
Staba, StructuralSections, Ward, Zeta, etc.). Individual sections and other elements are easily set as either user 
sections or special elements and stored in tables (libraries) for reuse. 

The construction rules previously implemented are applicable for existing construction systems, Advance ele-
ments, and other elements. 

Advance and CAD platform 

The latest AutoCAD
® 

version has been extended (through the ARX-Technology) with specific steel construction 
elements such as beams, plates and bolts. Advance elements are individual objects that are used like standard 
AutoCAD® objects. 

Advance is completely integrated into AutoCAD® making it easy and intuitive to learn. Advance benefits from 
the latest AutoCAD® ARX Technology and makes the best use whenever possible of the existing work method-
ology including manipulation tools on geometric elements, snaps and grips, etc. Therefore, users are immedi-
ately familiar with the basic tools. 

AutoCAD® serves both as a graphic engine and an object oriented database for Advance. The complexity of 
commands is reduced as Advance objects are processed within AutoCAD® tools and all information is stored in 
the DWG. 

Advanceôs integration within the AutoCADÈ user interface is fully optimized. All Advance tools are grouped by 
type in ribbons. 
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Technology 

Advance uses the latest standard industry technologies such as Windows and AutoCAD® for tight integration in 
the Microsoft Office environment. Advance information, construction rules and tables (libraries) are stored in 
MS-Access databases. 

The ODBC technology links the model and drawings and provides quick communication for joint macros con-
struction rules. 

The values entered in the Advance user menus are directly converted to a graphic display on the screen 
(through the MFC-user interface) so that the effects of a new value are viewed immediately. 

The Facet modeler enables large model manipulation with high speed since the file size can be kept small. 

Advance is MDI (Multi Document Interface) capable. This means that several drawings with models and linked 
detail drawings can be opened simultaneously within the same Advance session. With this functionality, ele-
ments are copied from one drawing to another using drag and drop. 

Communication options 

Advance elements are saved as proxy-graphics with lines or surfaces. Therefore, Advance DWGs can also be 
viewed in standard AutoCAD®. The saved proxy-graphics can be clicked through a system variable. 

From the Advance model, information transfer files are created by PCS (Program system in the steel construc-
tion) or PSS (Interface product of the steel construction). 

Individual preferences 

Advance has default values for immediate creation without extensive configuration. Advance is preconfigured to 
use common profile sizes, standard plate thicknesses, standard bolt information, etc. 

The default values are changed with the GRAITEC Advance Manager. 

The default intelligent joint settings based on section sizes are set to individual user requirements by saving the 
information in an easy to use library. 

Various drawing styles containing rules for dimensions, labeling and presentation of objects, are used for creat-
ing drawings from the model. Advance contains a variety of preset drawing styles accessible for automatic 
drawing creation: general arrangement drawings, single part shop drawings, assemblies and many more. 

Moreover individual drawing styles can be user defined. The creation and editing of user defined drawing styles 
is described in the Drawing Style Manager guide.   

 
 



 

  

 

Chapter 1 
General 

 
 In this chapter: 

ƴ System requirements 

ƴ Converting databases (Merging) 
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System requirements 

To successfully install Advance certain requirements have to be met.  

 

Converting databases (Merging) 

Old databases can be converted to new databases using the GRAITEC Advance Manager. This might be re-
quired on a new revision of Advance Steel or if users want to exchange information. 

Notes: Only the database from a previous version can be converted. 

The tables (libraries) cannot be converted if the structure of the tables (libraries) was changed. 

A column with author information is a prerequisite for converting databases. 

When upgrading to the new version of Advance Steel, almost all user settings from the previous version can be 
merged and then used in the new version. 

During the conversion operation any existing new entries in the source database are copied to the destination 
database, also entries that exist in both databases are compared and updated in the destination databases if 
any differences are found between them. 

Examples of database changes that can be converted: 

AstorBase.mdb:  

¶ New materials or coatings 

¶ New model roles 

¶ Symbol configurations  

AstorGratings.mdb: 

¶ New or modified gratings 

AstorRules.mdb:  

¶ Configurations done to the accepted profile sizes / classes by joints like the Purlin structural element 

¶ Saved joint library entries  

AstorSettings.mdb: 

¶ Modifications done to the default values 

¶ AstorProfiles.mdb: 

¶ New or modified profiles 

 Save the databases before converting them.  

1. Start the GRAITEC Advance Manager. 

2. From the Settings category, select Convert Databases. 
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Figure 8: GRAITEC Advance Manager ï Starting the conversion tool 
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3. In the next window, click Open Database. 

 

Figure 9: Loading databases to convert 

4. Select the old versions of the databases (*.mdb files). For example, search for the database Astor-
Base.mdb then click Open. 

The conversion tool will know automatically the equivalent Advance Steel 2014 database to which the 
merge is done. 

4. The database is loaded. Only the tables that can be converted are displayed. 

5. Select the tables to convert and click Convert. 

 

Figure 10: Selecting the tables to convert 

The tables are automatically converted and can be used with the new Advance Steel version. 

 

Figure 11: Finishing the conversion 



 

  

 

Chapter 2 
The 3D Model 

 
 In this chapter: 

ƴ Elements of the 3D model 

ƴ 3D Modeling workflow 
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Elements of the 3D model 

The Advance 3D model is built from elements such as beams, plates, structural elements, bolts, welds, fea-
tures, and joints. Once the model is finished, checked and numbered, all output like structured BOM, NC data, 
general arrangement and detail drawings can be completed. 

3D-Modeling 
 

Numbering 
 

Drawings 

     

    
BOMs / NC-Information 

Beam & Plate 

The 3D model is built mainly from Advance basic objects: 

¶ Beams created as section classes, simple sections, compound sections, or curved sections 

¶ Plates as rectangular plates or as polygon plates with any contour 

Beams and plates are created directly in the model and are displayed, by default, in the ówireframeô mode. 

 

Figure 12: Advance Beam and Plate (standard representation) 

 

Figure 13: Compound section and curved beam shown in the 'Hidden' representation 

Processing 

The basic objects (i.e., beams and plates) have available processing features. The most important processing 
types are: 

¶ Beam processing: trimming, coping, miter cuts, rectangular and circular contour cuts, or any type of con-
tour. 

¶ Plate processing: corner finishes, chamfers, outer plate contours and inner contours, etc. 

 

 



 ADVANCE STEEL USERôS GUIDE 
 

 

 19 

Processing of existing basic objects (e.g., beam trimming and coping) is displayed as green processing con-
tours within the object. The processing objects cannot exist alone and are part of a basic element (i.e., beam or 
plate). The object processing are edited as individual objects. 

  

Figure 14: Contour processing ï cope and corner section 

The variety of processing options in Advance allows for almost any beam and plate contour. 

 

Figure 15: Plate processing 

If a basic element is deleted all processing objects will also be deleted. 

Bolt patterns & welds 

The basic objects (i.e., beams and plates) can be connected with: 

¶ Bolt patterns (or holes only) 

¶ Welds 

These objects establish a connection between objects (e.g., beams and plates). This information is stored on 
the objects (i.e., beam or plate) including any bolt pattern (with its definition) or welds (with its relevant proper-
ties). Any individual element in the connection ñknowsò what holes, bolts, or welds it contains or with which ele-
ment it is connected. 

A bolt pattern can describe one or several bolts, which are automatically created in any plane together with the 
appropriate holes. 

  

Figure 16: Bolt Pattern, Weld Point 
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Changes in the bolt pattern automatically update the holes.  

The tools for creating bolt patterns are used for bolts in addition to: 

¶ Holes, slotted holes, countersunk holes, blind holes, threaded holes and punch marks 

¶ Shear studs 

The above are all created with their respective properties or definitions. 

It is also possible to create the various hole types as part of a bolt object and a separate hole object. 

Weld points are displayed as crosses in the model. 

Joints 

Another option for connecting the basic elements is the use of Advance joints. Joints are complex elements that 
consist of basic elements and dependent elements that are controlled by a construction rule.  

All individual elements in the joint, including their properties and processing objects, are held together and rep-
resented as a gray box (connection object). 

All connection objects and definitions are included in the gray box. 

Example: Haunch connection 

A portal column and a rafter are connected with an intelligent rule-based joint. For example, this is a 
haunch connection, including plates, stiffeners, and bolts. 

 

Figure 17: Connection object (gray box) 

The following joints are included in Advance: 

¶ Connections for North America: end plates, clip angle connections, base plate, flat bracings 

¶ Frame corners 

¶ Gable wall connections and pin-ended column connections 

¶ Ridge connections and splices 

¶ Platform connections, end plates, web connections, and shear plates 

¶ Gusset plates and diagonal bracing 

¶ Base plates and stiffeners 

¶ Tube connections 

¶ Turnbuckle bracing 

¶ Pylon construction connections 

The rules and structure of joints are stored in MS-Access tables (libraries). Adjustment of these rules to user 
requirements (or creation of new rules) is possible with knowledge of Advanceôs macro programming language. 

In addition to the joints provided in the standard Advance package, interactive (also called manual) joints can 
be created, stored and reused. 
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Structural elements 

Structural elements are an intelligent group of basic elements and dependent elements classified as follows: 
symmetrical goal post frames and portal frames, single-span bracings, purlin positions, various stairs, pylons, 
joists, and half trusses. 

These elements are created as a group of several basic elements with relationships to each other. Elements 
and their relationships are held together and stored with a structural frame. The structural frame is displayed in 
the model as a white continuous line (Figure 18). 

Example: Portal frame 

A portal frame consists of four sections: two grouped columns and two grouped rafters connected using 
a structural element macro. 

 

Figure 18: Portal Frame 

All changes to one element affect the entire group. If a rafter section is changed then the second rafter section 
will also be changed. The column sections of the frame behave in the same way. A change in the total height or 
the column height affects the entire structural element. 

Auxiliary objects 

Auxiliary objects are: 

¶ Grid axes or 

¶ Level symbols 

These objects do not belong directly to the frame but support the construction process. Nevertheless, they are 
important elements. 

Example: Building grid 

A building grid that corresponds to the dimensions of the construction forms the basis of 3D Modeling 
and helps with orientation in three-dimensional space. 

 

Figure 19: Building grid with portal frame 
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Special parts 

Objects that are not Advance standard objects can be created as special parts. When Advance creates draw-
ings and bills of material with special parts they are handled like standard objects. If these objects (special 
parts) are to appear in the bill of material, they must be provided with Advance properties. Advance information 
that can be attached is: 

¶ Weight 

¶ Material 

¶ Coating 

¶ Name 

¶ Commodity 

¶ Lot/Phase 

¶ Part mark (single part and assembly) 

¶ Model Role 

¶ Other 
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3D Modeling workflow 

 

 

Create a building grid 

 

 

 

Create beams, plates, structural elements 

 

 

 

Edit beams / plates (processes) 

 

 

 

Add Advance elements with joints / interactive connections 

 

 

 

Add other interconnecting members 

 

 

 

Controls / checks for collisions and measurements 

 

 





 

  

 

Chapter 3 
Advance interface 

 
 In this chapter: 

ƴ Starting Advance Steel 

ƴ Advance Steel user interface 

ƴ Using Advance 

ƴ Creating Advance objects 
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Starting Advance Steel 

To start Advance Steel: 

¶ Double click on the Advance Steel Icon on the desktop.  

Or 

¶ On the Windows task bar, click , then select All Programs > Graitec > Advance Steel and click the 
Advance icon. 

Advance Steel startup page appears. 

 

GRAITEC Resources 

Provides quick access to the License Utility and GRAITEC 
Advance Manager. 

GRAITEC Advantages 

Provides quick access to various online resources: 

ï Service packs 

ï Documentation 

ï FAQôs 

ï Forum 

My Projects 

Open existing projects and create new projects at any time. 

Samples 

Access a set of .dwg files containing models created with 
Advance Steel. 

Video 

Access a set of videos for a quick tour of Advance Steel. 

Figure 20: Advance Steel ï Startup page 

Starting a new project 

Advance Steel projects consist of a master file ï a .dwg file containing the model - and a set of derived files: 
detail drawings, BOMs, NC files, etc. 

When starting a new project, a template file is used. The template file contains important defaults like the cur-
rent coordinate system, the orientation, object snap settings, layer assignment and color definitions so that 
modeling can immediately begin. 

1. From the startup page, My Projects area, click New. 

Advance Steel automatically opens the folder where the templates are stored. 

2. Select the template (.dwt file) and click Open. 

Note: Always use the ASTemplate.dwt template to start the modeling project. 

Advance starts in a three-dimensional isometric view and the user interface appears. The User Coordinate 
System (UCS) is active and set to the World Coordinate System (WCS). All coordinate entries refer to the UCS. 
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Saving a project 

Save a project with an appropriate name in a DWG format. Use the Save button on the Quick Access Toolbar 
in the upper left corner of the screen. Each project should be saved in its own folder for easier file management. 

 

Figure 21: Save button on the Quick Access Toolbar 

Among other features, template drawings and files for certain drawing formats are delivered with Advance. 

Advance Steel user interface 

Advance Steel provides a complete environment for modeling and detailing steel structures. 

 

1: Quick Access Toolbar 

2: The ribbon 

3: Tool palettes 

4: The drawing area 

5: Command line 

6: Status bar 

Figure 22: Advance user interface 

Quick access toolbar 

The Quick Access Toolbar provides fast access to the most frequently used tools. The set of available tools can 
be extended. The Quick Access Toolbar can be placed above or below the ribbon. 

Adding buttons to the Quick Access Toolbar 

1. On the Quick Access Toolbar, click . 

2. Select More Commands from the displayed menu. 

3. From the left side of the Customize dialog box select the tools to add to the Quick Access Toolbar and click 
Add. Optionally, separators can be used. 

Another method to add a ribbon button to the Quick Access Toolbar is to right click the ribbon button and select 
Add to Quick Access Toolbar. 

 

Figure 23: Adding a button to the Quick Access Toolbar 
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The ribbon 

The Advance Steel ribbon contains a collection of panels grouped on tabs, according to category of tasks. On 
the panels, the buttons are grouped on different rows and include large buttons for the most frequently used 
functionalities. 

Some panels can be expanded by clicking the arrow on the bottom-left corner. 

 

Figure 24: Opening grid commands 

Some panels contain buttons that are tools or call flyouts. The flyout buttons have a black triangle on the right 
side. These flyouts automatically open when the button is pressed and held down. 

 

Figure 25: Opening welded beam commands 

Tool palettes 

The tool palettes contain other tools, complementary to the functionalities available on the Advance Steel ribbon. 

The drawing area 

The drawing area is the main area of the application window where the objects are created and edited.  

Command line 

Advance commands can be entered using the keyboard. Press <Enter> after each entry. 

Status bar 

The status bar displays information regarding the program status during different phases of the project. It also 
contains buttons that provide access to the configuration of certain parameters: snap modes, object tooltips 
content, current coordinate system, and working units. 
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Using Advance Steel 

All advance commands can be accessed from the ribbon and from the tool palettes. The tool palettes contain 
other tools, complementary to the functionalities available on the Advance Steel ribbon. 

Tips The ribbon can be minimized, thus enlarging the drawing area. 

 The tool palettes can be docked to one side. 

Using Advance Steel ribbon 

For easier access, the most used Advance Steel tools are placed on the Home tab. Each panel contains tools 
that are relevant from other tabs. This tab accelerates the construction work by having frequently used com-
mands in one place. 

It also contains the most used tools for displaying the drawing such as visual styles, view. 

 

Figure 26: Home tab 

Modeling tools 

All modeling tools, essential for creating a three-dimensional model, are available on two ribbon tabs: Objects 
and Extended modeling.  

¶ The Objects tab contains tools for creating basic Advance elements: grids, beams, plates, gratings, bolts, 
holes, shear studs, welds, and concrete elements. 

 

Figure 27: Objects tab 

¶ The Extended modeling tab contains tools for creating and modifying complex objects (such as structural 
elements, stairs, railings, ladders), the Connection vault, the commands for handling joints and connection 
objects, specific tools for working in a multi-user environment. 

Important checking tools (i.e., collisions in the model and checking databases), which are required during 
construction are placed on the Checking panel. The User sections panel includes all required commands 
for creating custom sections (can be added directly in tables (libraries)). 

Additionally, a large set of tools for creating and editing basic 3D solids are grouped on three panels. 

 

Figure 28: Extended Modeling tab 
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Detailing tools 

All the tools necessary during the drawing creation process are grouped on two ribbon tabs: 

The Output tab contains all commands pertaining to numbering, drawing creation, automatic drawing creation 
with processes, and the Document Manager. The predefined drawing styles are different for each installation. 

 

Figure 29: Output tab 

The Labels & Dimensions tab contains tools for managing the details and the revision process and for creating 
additional dimensions, labels, level symbols etc. 

 

Figure 30: Labels & Dimensions tab 

Standard CAD entities and utilities 

The Utilities tab contains almost all useful tools during the drawing process: 

¶ Layer management tools 

¶ Simple CAD entities (lines, polylines, circles, etc.) 

¶ Standard editing utilities (cut, paste, delete, etc.) 

¶ Creating and editing Object Data 

¶ Measurement tools 

 

Figure 31: Utilities tab 

Visualization tools 

The View tab contains tools for manipulating the view in 2D and 3D, for displaying the model (change the visual 
style) and displaying interface elements (tool palettes, windows, viewports). 

 

Figure 32: View tab 

Using the tool palettes 

On the tool palette, special Advance commands for copying, rotating and mirroring connections are included. 

To display the tool palette: 

¶ On the View tab, click . The tool palette appears. 

The tool palette can be docked on one side of the application window. 
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Starting an Advance Steel command 

Start an Advance command by clicking a button on a ribbon panel or on the tool palette. The command appears 
on the command line at the bottom of the screen. 

Other important tools for using Advance Steel 

¶ To cancel a command in Advance, press the <Esc> key. 

¶ The current command and prompts are displayed on the command line window at the bottom of the screen. 
Press the <F2> key to open and close the command line window. 

¶ The right mouse click behaves like the Enter key. 

¶ When the cursor hovers over a button of a panel, the button's tooltip appears. 

¶ The Undo command cancels one or several commands. 

 

Figure 33: Undo command on the Quick Access Toolbar 

¶ The Match properties command copies properties from one object to another. The transferred properties 
are selected from a list. 

 

Figure 34: Match properties command on the Utilities panel 

Creating Advance Steel objects 

Advance objects are created in 3D-space using the program tools. The object's orientation depends on the cur-
rent UCS (User Coordinate System). 

Points created by selecting or using coordinates determine the position and orientation of the object in space. A 
dialog box will appear in which different settings (e.g., geometric sizes, etc.) and drawing styles can be 
changed (e.g., dimension/label on the drawings). 

The settings in the dialog box are sorted on different tabs that vary based on object type. 

 

Figure 35: Plate dialog box 

When a dialog box field (e.g., dimension, position, etc.) is changed the model updates instantly (model preview): 

¶ By clicking the next field, 

¶ By closing the window (click the X in the right upper corner), 

¶ By using the <TAB> key to move to the next field or 

¶ By using the Enter key to select the value in the current field. 

Initial settings of an object (e.g., a plate) are stored and can always be recalled and updated using the same 
dialog box. 
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Advance will recall the last dialog box values and preferences until the next time the same tool is used. After 
restarting Advance, the dialog boxes return to the default settings. 

The default settings are restored using the system menu of the dialog box (right click the header line of the dia-
log box). By clicking Use defaults on this system menu, the dialog box entries return to the default settings. 

Object properties 

All created objects have default Properties that can be changed in the Advance Properties dialog box, which 
automatically appears upon creating an object. 

 

Figure 36: Geometric and non-graphic properties 

The object properties are classified as follows: 

¶ Geometric Properties (i.e., position in the model and shape) 

They are set on creation and can be changed afterwards using standard CAD commands (e.g., move, ro-
tate, copy, etc.) and grips. 

¶ Properties specific to the used CAD platform 

They are set in the property list and are changed using the Properties command. 

¶ Technical properties  

They are properties for the on-screen representation (e.g., representation of a beam with or without pro-
cessing) and non-graphic properties (e.g., material, name, etc.). This information goes in the structured 
BOMs and drawings. 

  

Figure 37: Beam ñfeaturesò and ñstandardò representation 

To open an object dialog box double click on the object. 

Another way to access the properties is to select the object(s) and with a right mouse click select Advance 
properties from the context menu. 

Layer 

Advance objects are, by default, created on the active Layer but can also be placed automatically on specific 
layers with different properties. This feature is set in the ASTemplate.dwt DWG drawing template file using the 
GRAITEC Advance Manager. 



 

  

 

Chapter 4 
Creating a 3D Model 

 
 In this chapter: 

ƴ Creating a building grid 

ƴ Creating a beam 

ƴ Creating plates 

ƴ Coordinate systems 

ƴ Beam processing 

ƴ Plate processing 

ƴ Changing Advance objects 

ƴ Advance command properties 

ƴ Representation Type ï Snaps ï 
Grips 

ƴ Bolt and Hole Patterns / Shear 
Studs 

ƴ Welds 

ƴ Connections 

ƴ Working methods I 

ƴ Structural elements 

ƴ Joints and connection objects 

ƴ Special parts, special sections 

ƴ Working methods II 

 
























































































































































